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Wave Introduction
Agilent Seahorse XFe
Agilent Seahorse Wave software is the experiment design, instrument control, 
data acquisition, data analysis, and file management software for Agilent 
Seahorse XF, XFe, and XFp Analyzers. This user guide provides detailed 
information on each function in Wave software. 
Quick Start
The typical Agilent Seahorse XF workflow can be outlined in three steps: 

• Design your experiment

• Acquire data

• Analyze results

Design your experiment 

First, design your experiment, called an assay template file. Wave software 
contains several default assay template files for the standardized Agilent 
Seahorse assay kits (for example, XF Cell Mito Stress Test). Use the Agilent 
Seahorse default assay templates and customize as necessary. Wave also 
provides a Blank assay template for those users who prefer to create a new 
assay template for each experiment. 

Wave Desktop is the preferred software for designing or customizing assay 
templates for Agilent Seahorse XFe and XFp Analyzers, however the same 
functions can be performed using Wave Controller software (for Agilent 
Seahorse XFe Analyzers only). See “Create/Edit Assay Templates" on page 14 
more for information on creating/customizing assay templates.

Acquire data

After creating an assay template for the experiment, transfer the template to 
the XFe Analyzer using a USB flash drive or network drive (active network 
connection required). If the assay template is created using Wave Controller on 
the XFe Analyzer, the assay can be performed immediately.

Analyze results

After completing the assay, transfer the assay result file from the XFe or XFp 
Analyzer to Wave Desktop for data analysis. Wave Controller automatically 
saves a backup copy of the assay result file locally on the XFe Controller 
(computer).
96 and XFe24 Analyzers Wave 2.4 User Guide 3



Wave Home: Views
4

Templates 

View and organize your assay template files from the Templates view. Use the 
Create, Export, Import, and Duplicate buttons to easily manage your list of 
template files.

Results 

View, open, and manage all your assay result files from the Results view. Click 
the Options button to configure Favorite Places, file locations where assay 
result files are stored, such as a network directory or local PC folder. 

Catalog 

Use the Catalog to store Compounds, Pretreatments, Media, and Cells that are 
frequently used for template design and modification. Wave provides a 
prepopulated Catalog of the standardized Agilent Seahorse kit components as 
well as other reagents, media, and cell types. You can add (and delete) entries 
within the Catalog view only. 

Options 

Configure the local Template and Catalog file directories as well as the default 
Instrument Protocol times.

Help 

Agilent Seahorse Technical Support contact info, software version and 
auto-compile feature for System Files.

Figure 1 Wave home views
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Wave Home: Templates 
Agilent Seahorse XFe
The Templates view displays all assay template files saved on the XFe 
Controller (Wave Controller) and on your PC (Wave Desktop). (See Figure 2.) 
An assay template (.asyt) file contains the required information to run an 
experiment on the XFe and XFp Analyzers - Group Definitions, Plate Map 
layout, and Instrument Protocol. Assay templates can be reused for the same 
assay, or customized and saved as a new template for another assay on the 
XFe/XFp Analyzer. 
Figure 2  Templates display
Assay templates are color coded based on the type of assay template. 
(See Table 1.)

Table 1  Assay templates

Template type Template color

Agilent Seahorse Blue

Blank White

User-customized Green
96 and XFe24 Analyzers Wave 2.4 User Guide 5



6

Wave software automatically installs 10 default Agilent Seahorse assay 
template files, which contain assay-specific information for standard Agilent 
Seahorse assays. The blank and Agilent Seahorse templates are not editable; 
modifications made to a Agilent Seahorse template will be saved as a new 
assay template (green icon). (See Figure 3.)

• Blank 

• XF Cell Energy Phenotype Test 

• XF Cell Mito Stress Test (Acute Injection)

• XF Glycolysis Stress Test 

• XF Glycolysis Stress Test (Acute Injection)

• Dependency - XF Mito Fuel Flex Test

• Flexibility - XF Mito Fuel Flex Test

• XF Buffer Factor Assay

• XF CO2 Contribution Factor Assay

• XF Glycolytic Rate Assay

• XF Glycolytic Rate Assay (Induced Assay)

Figure 3  Assay template color examples

Blank 
template

Agilent Seahorse 
default template

User-customized 
template
A
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Wave Home: Results 
Agilent Seahorse XFe
The Results view displays recently opened assay result files, the corresponding 
file directory where each assay result file is located, and Favorite Places. (See 
Figure 4.) Opening a new assay result file displays the default analysis view - 
the Quick View. After modifying and saving an assay result file, Wave 
automatically displays the last modified analysis view the next time the assay 
Results file is opened. 
Figure 4  Wave home results
96 and XFe24 Analyzers Wave 2.4 User Guide 7
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1 Design Agilent Seahorse Experiments with Wave
Create/Edit Assay Templates
14
To create a new assay template or modify an existing template:

1 Open Wave 2.4.

2 Click Templates (below Wave Home).

3 Select the Blank template, a Agilent Seahorse Default template, or a 
User-customized template and click Open or double-click the template icon.

4 Add, remove, or modify group definitions; and create new assay groups. 
(See “Step 1: Group Definitions” on page 15.)

5 Assign groups to the Plate Map. (See “Step 2: Plate Map” on page 20.)

6 Review or modify Instrument Protocol. (See “Step 3: Instrument 
Protocol” on page 21.) 

7 Save the template, transfer it to XFe/XFp Analyzer. (See “Saving Assay 
Templates” on page 28.)

8 Run the assay. (See “Step 4: Run Assay” on page 24.)
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.4 User Guide



Design Agilent Seahorse Experiments with Wave 1
Step 1: Group Definitions
Agilent Seahorse XFe
Group definitions is comprised of four components: 

• Injection Strategies

• Pretreatments

• Assay media

• Cell type
Injection strategies

Figure 5 Group definitions 
Injection strategies describe the contents of up to four injections (one for each 
of the four ports: A, B, C, and D), more than one injection strategy can be 
performed in an assay. For example, on the same plate, two injection strategies 
can be defined for the XF Cell Mito and XF Glycolysis Stress Test.

To add one or more injection strategies:

1 Click Add next to Injection Strategies. (See Figure 5.)

2 Enter a name for the injection strategy if desired. The default name when 
adding new injection strategies is Inj. Strategy # (# corresponds to how many 
injection strategies have already been added).

3 Next, specify the contents of each injection starting with Port A. Click 
Add Compound, and type in a compound name (for example oligomycin), or 
use the Compound Catalog drop-down menu to select a compound from the 
catalog. (See Figure 6 on page 16.)
96 and XFe24 Analyzers Wave 2.4 User Guide 15
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1 Design Agilent Seahorse Experiments with Wave
4 If additional injections are called for from ports B, C, and D, repeat step 3. 
Figure 6 Additional injection ports
Figure 7 shows two defined injection strategies for the Agilent Seahorse XF 
Cell Mito Stress Test assay for different concentrations of FCCP: 

• Mito Stress Test - 1 µM FCCP 

• Mito Stress Test - 2 µM FCCP

Figure 7 Injection strategies for the Agilent Seahorse XF Cell Mito Stress Test assay
Pretreatments
Pretreatments describe a treatment the cells have received prior to performing 
the assay, such as a genetic manipulation or prolonged exposure to 
compounds.

To add one or more Pretreatments:

1 Click Add next to Pretreatments. (See Figure 8.)

2 Enter a name for the pretreatment or use the Pretreatment drop-down 
menu to select a pretreatment from the catalog. The default name when 
adding new pretreatments is Pretreatment # (# corresponds to how many 
pretreatments have already been added).

3 If desired, specify the type of pretreatment using the Description field. 

Figure 8 displays two Pretreatment conditions, Control and Experimental.

Figure 8 Pretreatment conditions
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.4 User Guide



Design Agilent Seahorse Experiments with Wave 1
Assay media
Agilent Seahorse XFe
Assay Media describes one or more assay mediums used in the assay. Record 
the medium and supplements for each medium used in the assay: 

To add one or more Assay Medium:

1 Click Add next to Assay Media. (See Figure 9.)

2 Enter a name for the assay media, or use the Media drop-down menu to 
select a media from the catalog. The default name when adding a new assay 
media is Assay Media # (# corresponds to how many assay media have 
already been added). (See Figure 9.)

3 Enter additional details if desired for: Source, Supplements, Prepared By, 
and so forth. 

Figure 9 Assay Media 
Cell type
Cell Type describes the biological material/samples used, including 
information about the cell line, seeding density, and passage number.

To define one or more Cell Types:

1 Click Add next to Cell Type. (See Figure 10.)

2 Enter a name for the cell type, or use the Cell Line drop-down menu to 
select a cell type from the catalog. The default name when adding a new cell 
type is Cell Type # (# corresponds to how many cell types have already been 
added). (See Figure 10.)

3 If desired, enter additional details for: Seeding Density, Lot, Source, and 
Passage number. 

Figure 10 Cell Type
96 and XFe24 Analyzers Wave 2.4 User Guide 17



1 Design Agilent Seahorse Experiments with Wave
Duplicate and Delete
18
The three dots next to each group definition enable two functions: Delete the 
group definition entry and Duplicate the group definition entry. 

Figure 11 Duplicate and Delete function toggle
Automatically generate groups
After creating the individual Group Definitions, create assay groups, and 
assign the various conditions to each group based on your experimental 
design. This can be done automatically by clicking the Generate Groups button. 
This function uses the independent Group Definitions to calculate the number 
of groups, assuming every possible combination of independent conditions. An 
example of the combinatorial logic using the Group Definitions below shows 
how this function results in a total of eight unique groups (2 * 2 * 1 * 2 = 8): 

• Injection Strategies = 2 (Mito Stress Test - 1 µM FCCP and Mito Stress Test - 
2 µM FCCP)

• Pretreatments = 2 (Control and Experimental)

• Assay Media = 1 (Mito Stress Test Assay Medium)

• Cell Type = 2 (C2C12 and HepG2)
Figure 12 Automatically generate groups 
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.4 User Guide



Design Agilent Seahorse Experiments with Wave 1
Manually generate groups
Agilent Seahorse XFe
If desired, Assay groups can be created manually: 

1 Click Add Group to create Group 1. (See Figure 13.)

2 Use the drop-down menus to assign the appropriate Group Definitions to 
Group 1. (See Figure 14.)

3 Repeat for each manually generated group.

To change the name of the group, double-click the Group 1 text, or right-click 
and select Edit. To change the color of the group, use the drop-down color menu 
next to the group name. After adding Group Definitions and generating 
groups, assign groups to the Plate Map. (See “Step 2: Plate Map” on page 20.)

Figure 13 Add groups

Figure 14 Duplicate and Delete function toggle
96 and XFe24 Analyzers Wave 2.4 User Guide 19



1 Design Agilent Seahorse Experiments with Wave
Step 2: Plate Map
20
The Plate Map displays group assignments on the Cell Plate. Wave uses the 
group assignments on the Plate Map to calculate group statistics (average rates 
for each measurement performed and the standard deviation or standard 
error for each rate measurement) after the assay has completed. There are 
two ways to assign groups to the Plate Map. 
Assign groups automatically
Click Distribute Groups. Wave automatically determines the maximum number 
of replicates per group, and assigns wells to each group starting with column 
1. (See Figure 15.)

Figure 15 Distribute Groups
Assign groups manually
1 Click the group in the Groups list on the left.

2 Click the well on the Plate Map to assign that individual well to the selected 
group. You can assign an entire row or column to a group by clicking the 
row or column label, or drag-and-drop to select an area of the Plate Map to 
assign to the selected group. (See Figure 15.)
Background wells
Background wells have default Plate Map coordinates based on the type of XFe 
or XFp Analyzer. You can modify the coordinates of the background wells or 
add/remove background wells if desired. Use the steps described in “Assign 
groups manually”.
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.4 User Guide



Design Agilent Seahorse Experiments with Wave 1
Step 3: Instrument Protocol
Agilent Seahorse XFe
The Instrument Protocol is the series of commands performed during an assay, 
the timing of when these commands occur, and the duration. The default 
Agilent Seahorse assay templates have a preconfigured Instrument Protocol, 
and do not require modification. 
Default protocol commands 
Every Instrument Protocol includes the following steps:

• Calibrate (always ON)

• Equilibrate (highly recommended for every assay)

• Baseline Measurement cycle

Calibration

Calibrate is always the first step in a protocol and cannot be disabled. The 
Calibrate step reads the coefficients of the Sensor Cartridge and Cell Plate to 
ensure accurate data acquisition.

Equilibration

Equilibration ensures temperature stability before beginning an assay. The 
default setting for Equilibration is ON. Equilibrate can be disabled although 
this is strongly discouraged.

Figure 16 Default protocol commands
Measurement cycles
Measurement cycles indicate the steps in the Instrument Protocol when rate 
data is collected for oxygen consumption rate (OCR) and extracellular 
acidification rate (ECAR). The standard Agilent Seahorse Instrument Protocol 
consists of three measurement cycles before the first injection (called 
Baseline) and three measurement cycles after each port injection. Each 
measurement cycle consists of three commands: Mix, Wait, and Measure.
96 and XFe24 Analyzers Wave 2.4 User Guide 21



22

1 Design Agilent Seahorse Experiments with Wave
• Mix: The amount of time to raise/lower the sensor cartridge to ensure 
analytes and drug compounds are uniformly mixed in each well before/after 
an injection, as well as to reintroduce oxygen to the well after forming the 
microchamber for each measurement.

• Wait: The amount of time to delay the Measurement step after the Mix step. 
This command is required for the XFe24 Analyzers in every assay, but may 
be added to Instrument Protocol for any analyzer.

• Measure: The amount of time to record the flux of analytes in the transient 
microchamber once the sensor cartridge probes are lowered following a Mix 
(or Wait) command.

The default measurement cycle times are:

• Agilent Seahorse XFe96 and XFp Analyzer: 3 minutes Mix; 0 minutes Wait; 
3 minutes Measure

• Agilent Seahorse XFe24 Analyzer: 3 minutes Mix, 2 minutes Wait, 3 minutes 
Measure

Baseline measurement cycle 

The Baseline measurement cycle is the starting point for every Agilent 
Seahorse assay and consists of three measurements before the first injection. 
Data acquired during the Baseline measurement cycle provide valuable 
information about the bioenergetic status of the cells under starting 
conditions. 

Figure 17 Default protocol commands
Injections
To add an injection command to the Instrument Protocol, click Injection. Wave 
automatically selects the compound injection ports sequentially, therefore, the 
first time you click Injection, port A will be assigned to injection 1. A grayed out 
port indicates it has already been assigned to an injection. (See Figure 18 on 
page 23.)
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.4 User Guide
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Agilent Seahorse XFe
Wave also automatically adds the measurement cycles after adding an 
injection. Default Mix, Wait, and Measure times are instrument-dependent, and 
can be modified in Instrument Options (Wave Home > Options).

Figure 18 Measurement information
Edit measurement details
To view and edit the Mix, Wait, and Measure timing, click the drop-down arrow 
next to Edit Measurement Details. (See Figure 18.) Use your keyboard to enter 
specific Mix, Wait, and Measure times or adjust the number of Cycles for each 
measurement. The up and down arrows can also be used. To achieve optimal 
results, a minimum of three cycles per measurement is recommended. The 
default Mix, Wait, and Measure times are instrument-dependent, and can be 
modified in Instrument Options (Wave Home > Options).

To change the name of each command in the Instrument Protocol, click the text 
field at the top of the column. (See Figure 18.)
Custom cycles
Most Agilent Seahorse assays do not require the use of custom cycles, however 
depending on the type of experiment or your experiment design, a custom 
cycle may be appropriate. To add a custom cycle command to the Instrument 
Protocol, click Custom. A custom cycle enables multiple Mix and Wait steps 
without a Measurement. Note that the Agilent Seahorse XF Report Generators 
are not compatible with Instrument Protocols containing a custom cycle.
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Step 4: Run Assay

Assay summary
24
General Information 

The General Information section provides editable fields for project 
information, plate information, or other important notes related to the assay. 
Any information entered on this view is saved in the assay result file (*.asyr). 

Figure 19 Assay summary
Errors and Warnings 
All errors or warnings are displayed on the right side of the Run Assay step. 
(See Figure 20.) Prior to transferring the template to the XFe or XFp Analyzer, 
correct any errors that are displayed. A typical error message is the 
notification that some assay wells have not been assigned to a group on the 
Plate Map. If a template is designed correctly, Wave displays an All Set 
confirmation message. (See Figure 20.)

Figure 20 Error and Warning messages
Advanced options 
Email settings (XFe Analyzers only)

This feature applies to Wave Controller software only, and requires an active 
internet connection on the XFe Analyzer. Recipients must be added before 
starting an assay. Wave Desktop does not email assay result files. 
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.4 User Guide
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Agilent Seahorse XFe
To add an email address: 

1 Open the template file.

2 On the Run Assay navigation step, click Show Advanced Options. 
(See Figure 21.)

3 Type in the email address below Email Settings, and click Add. 
(See Figure 21.)

4 Repeat for each email address.

Port volumes and Version info

Adjust the default Port Volume values using the up/down arrows, or by typing in 
a value using your keyboard. This is for notation-purposes only, and does not 
affect data calculations. (See Figure 21.)

Version Information displays the Wave software version along with Agilent 
Seahorse XF File version info (internal-use only). (See Figure 21.)

Protocol summary

To display a summary view of the Instrument Protocol, click Protocol. 
(See Figure 22.) To edit the Instrument Protocol, click the Instrument Protocol 
navigation step before running the assay on Wave Controller, or 
saving/transferring the assay template from Wave Desktop to the XFe or XFp 
Analyzer.

Figure 21 Advanced Options

Figure 22 Protocol
96 and XFe24 Analyzers Wave 2.4 User Guide 25



26

1 Design Agilent Seahorse Experiments with Wave
Group summary

To display a summary view of the Group Definitions and Plate Map, click 
Group. (See Figure 23.) To edit the Group Definitions or Plate Map, click the 
Group Definitions or Plate Map navigation step before running the assay on Wave 
Controller, or saving/transferring the assay template from Wave Desktop to the 
XFe or XFp Analyzer.

Port (A, B, C, or D) summary

Click Port A (B, C, or D) for a summary of each injection from the selected port. 
(See Figure 24 on page 27.) The summary information includes:

• Compound concentration

• Name of the solvent (if specified)

• Percentage of solvent used for each compound

• Port volume

To modify the compound name, compound concentration, solvent name or 
percentage, click the Group Definitions navigation step, then select the 
appropriate Injection Strategy to edit before running the assay on Wave 
Controller, or saving/transferring the assay template from Wave Desktop to the 
XFe or XFp Analyzer.

Figure 23 Group Summary
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.4 User Guide
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Agilent Seahorse XFe
Print summary

To print or save a PDF of the Assay Summary, Protocol, Group, and Port A-D 
summaries for the assay template, click Print Summary. 

Figure 24 Port A summary
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Saving Assay Templates
28
After editing an assay template, click the Save button to overwrite the template 
with the newly modified details/content. To create a new template file, and 
preserve the original template file details, click the Save As button. 

Click Save As to display the Save As Template window (See Figure 26.): 

1 Enter the name of the assay template in the Name field (required). 

2 Enter the Author name (optional).

3 Enter a description of the assay in the Description field (optional).

4 Click Save. 

Figure 25 Saving options

Figure 26 Save As Template window
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.4 User Guide
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This chapter applies to Wave Controller software for Agilent Seahorse XFe96 
and Agilent Seahorse XFe24 Analyzers ONLY. The functions described in this 
chapter do NOT apply to Wave Desktop or Agilent Seahorse XFp Analyzer 
software.

Creating assay template files on Wave Desktop and Controller

Assay template files (.asyt) can be designed using Wave Desktop and Wave 
Controller. Assay templates created using Wave Controller can be run 
immediately after designing the template. Assay templates created using Wave 
Desktop must be transferred to Wave Controller to perform an assay. For 
nonnetworked XFe Analyzers, assay templates must be exported from Wave 
Desktop to a USB flash drive, then imported to Wave Controller. If the XFe 
Controller has an active network connection, assay template files can be 
transferred/imported directly through a shared network location.
29Agilent Technologies



2 Perform Assay on the Agilent Seahorse XFe Analyzer
Transfer Assay Template(s) to an Agilent Seahorse XFe Analyzer
30
Several options to import assay templates to Wave Controller are outlined 
below.
Transfer assay template using a USB flash drive
Option #1:

1 Save template to a USB flash drive.

2 Plug the flash drive into the USB port on the Agilent Seahorse XFe 
Controller.

3 Select the USB flash drive, and locate the template file(s) (.asyt).

4 Double-click the assay template to automatically import to Wave Controller 
software.

Option #2: 

1 Save template to a USB flash drive.

2 Plug the flash drive into the USB port on the Agilent Seahorse XFe 
Controller.

3 Click Templates.

4 Click Import.

5 Select the USB flash drive, and locate the template file (.asyt).

6 Select one or multiple template files on the USB flash drive, then click Open.
Transfer assay template using a network drive
Option #1:

1 Power ON the XFe Controller (if OFF).

2 Start Wave Controller software.

3 Locate the assay template file (.asyt) in the network directory.

4 Double-click the assay template to automatically import to Wave Controller.

Option #2:

1 Power ON the XFe Controller (if OFF).

2 Start Wave Controller software.

3 Click Templates.

4 Click Import.

5 Locate the template file (.asyt) in the network directory.

6 Select one or multiple template files on the network drive, then click Open.
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Start Your Agilent Seahorse XF Assay
Agilent Seahorse XFe
After customizing or transferring an assay template to Wave Controller, click 
Start Run to begin the XFe assay. 

Once an assay is started, access to Wave Home and other assay template and 
CAUTION
assay result files is disabled until the assay is completed. Transfer all Agilent 
Seahorse files from Wave Controller before starting an assay.
1 Click Start Run, and select a location to save the assay template file. The 
assay result file will be saved in the same location following assay 
completion. Assay template and result files can be saved to a USB Flash 
Drive, shared network directory, or locally on the XFe Controller. Wave 
Controller will also automatically save a backup assay result file locally on 
the XFe Controller in the location: C:\ProgramData\ Seahorse Bioscience, 
Inc\Seahorse Wave\Assays.

2 After selecting a save location, the tray door on the XFe Analyzer will open. 
Place the Sensor Cartridge (hydrated and loaded with compounds) along 
with the Utility Plate onto the tray. Ensure the Cartridge fits properly on 
the Utility Plate, the lid is removed from the Cartridge, and the direction of 
the Cartridge is in the proper orientation.

3 After loading the Sensor Cartridge and Utility Plate, press I’m Ready to 
initiate Sensor Cartridge Calibration. The time to complete Calibration for 
assays at 37 °C is approximately 10-20 minutes. For assays performed at 
temperatures other than 37 °C, an additional 30 minutes of PreCalibration 
time will be added to ensure accurate data acquisition. 

4 After completing Calibration, Wave Controller will display the Load Cell 
Plate message prompt. Click Open Tray to eject the Utility Plate and load the 
Cell Plate. Ensure the lid is removed from the Cell Plate before loading.

Figure 27 Load Calibrant Utility Plate prompt

Figure 28 Load Cell Plate prompt
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2 Perform Assay on the Agilent Seahorse XFe Analyzer
5 Click Load Cell Plate to initiate Equilibration. Once Equilibration has 
finished, the assay will begin acquiring the first Baseline measurement. 

6 After completing the final Instrument Protocol step, the assay will finish 
and display an Unload Sensor Cartridge message prompt. To eject the 
Sensor Cartridge and Cell Plate from the XFe Analyzer, press Eject. 

7 The assay result file will automatically save to the location specified prior 
to starting the assay, and can be opened immediately following the assay 
using the on-screen Assay Complete prompt. 

Figure 29 Load Cell Plate prompt

Figure 30 Unload Sensor Cartridge prompt

Figure 31 Assay Complete prompt
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Add and Remove Measurement Cycles in Runtime
Agilent Seahorse XFe
Figure 32 Real-time measurement cycle data
During a Agilent Seahorse XF assay, data is acquired, calculated, and 
presented in the real-time. For certain assays, it may be necessary to add or 
remove measurement cycles in real-time. 

Wave Controller 2.4 enables real-time Instrument Protocol modification for 
commands that have not yet been executed. To display the Instrument Protocol 
for the selected command, click on an Instrument Protocol step above the data. 
(See Figure 33.)

Figure 33 Selected command instrument protocol
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2 Perform Assay on the Agilent Seahorse XFe Analyzer
Click Edit Measurement Cycles to display the Edit Number of Cycles window. 
(See Figure 34.) Use the up/down arrows (or manually type a number) to 
add/remove measurement cycles from the selected command. 

Figure 34 Edit Number of Cycles
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Wave Controller Widgets
Agilent Seahorse XFe
The Widget icons are located on the lower left side of Wave Controller 
software, and display the status XFe Analyzer, current temperature, and 
controls to eject/insert the tray and raise/lower probes. 

t Status widget: Connection status between the XFe 
Controller (computer), Wave Controller (software), 
and the XFe Analyzer. 

Temperature widget: Current tray temperature 
and heater status display. 

Tray widget: Manually eject or insert tray, with or 
without a Utility Plate or Cell Plate. 

Probes widget: Manually unload a Sensor 
Cartridge and raise/lower the probes. 
XFe Assays at non-37 °C temperatures 
Agilent Seahorse XFe Analyzers have been validated to deliver desired target 
temperatures in the range of 16-42 °C provided the ambient room temperature 
is 12-20 °C below the target temperature, and in the validated operational 
room temperature range of 4-30 °C. To understand the relationship between 
the sample temperature and ambient temperature, see Figure 35 on page 36 
for the temperature chart.
Required operational and assay guidelines
• For all non-37 °C operation, the XFe Analyzer must equilibrate overnight in 
required ambient temperature.

• If required to set up the XFe Analyzer in cold room, avoid direct fan 
sources. (See Figure 35 on page 36.)

• For all non-37 °C operation, the tray heater must remain ON, do NOT turn 
the tray heater OFF.
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2 Perform Assay on the Agilent Seahorse XFe Analyzer
• For assay temperatures below 30 °C, hydrate the Sensor Cartridge in the 
dark at room temperature. 

• Prior to starting an assay, an additional 30 minutes of precalibration 
equilibration time has been added to ensure temperature stability. 

To adjust the Target Temperature (set point) using the up/down arrows, click 
on the Temperature Widget to display the Tray Temperature window. (Figure 37 
on page 37.) Ensure your ambient conditions support the desired target 
temperature (12-20 °C above ambient). Refer to the temperature chart shown 
in Figure 35. 

Figure 35 Temperature chart
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Agilent Seahorse XFe
Figure 36 Temperature widget 

Changing the Target Temperature requires OVERNIGHT equilibration to the new set point.
NOTE
Other Temperature Widget functions are:

• Turn the heater ON/OFF.

• Set the tolerance range for temperature fluctuation. If the temperature is 
above or below the acceptable tolerance range from the temperature set 
point, the Temperature Widget will change color (Figure 38), and the Status 
Indicator light (top of the XFe Analyzer) will change from blue to amber. 
For networked XFe Controllers, Wave Controller software will 
automatically send an email notification to specified recipients.

To save any changes on the Tray Temperature window, click Save.

Figure 37 Tray Heater window

Figure 38 Temperature widget color change
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2 Perform Assay on the Agilent Seahorse XFe Analyzer
Set alarm (Temperature tolerance range)
38
To set the alarm: 

1 Check the Alarm On box in the Tray Temperature window.

2 Click Save.

Disable the alarm by unchecking the Alarm On box, then click Save. If the Tray 
Temperature exceeds the Tolerance Range and the alarm is activated, click 
Reset Alarm to acknowledge and reset the Tray Temperature alarm. 

To ensure the Tray Temperature starts within the Tolerance Range, check the 
current temperature of the XFe Analyzer before beginning an assay. For any 
suspected temperature issues or unexpected temperature fluctuations, contact 
Agilent Seahorse Products Technical Support.

Figure 39 Temperature Alarm
Tray control widget
Use the Tray Control Widget to manually eject a Utility Plate or a Cell Plate in 
XFe Analyzer:

1 Click the Tray Widget. (See Figure 40.)

2 Click Tray Out, and remove the Utility Plate or Cell Plate.

3 To insert the tray and maintain the Target Temperature, click Tray In.

Figure 40 Tray control widget
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Probe control widget
Agilent Seahorse XFe
Use the Probes Widget to load/unload a Sensor Cartridge or raise/lower 
probes. To display options and select the appropriate action, click the Probes 
Widget. (See Figure 41.)

Figure 41 Probes control widget
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XFe Status Indicator
40
During an assay, the Status Indicator light on the top of the XFe Analyzer will 
change color if a task requires user interaction or if an error has occurred, 
such as:

• To load a Sensor Cartridge or Cell Plate

• To remove a used Sensor Cartridge and/or Cell Plate

• To accept or cancel an assay if one or more wells did not calibrate properly 
after Calibration

• Any errors that can occur during the run, such as barcode read errors for 
the Sensor Cartridge, Cell Plate, or a protocol error.  
Barcode Errors
The XFe Analyzer reads and records the Cell Plate and Sensor Cartridge 
barcodes before beginning an assay. A Barcode Read error will be displayed on 
the rare occasion the barcode cannot be read. (See Figure 42.) Contact Agilent 
Seahorse Technical Support to assist with resolving this error and to start the 
assay. 
Cartridge barcode read failure
For any Sensor Cartridge barcode read errors, Wave Controller will display the 
message shown in Figure 42 and three corrective actions: 

• Open Tray: Eject the Sensor Cartridge to inspect barcode quality or to reverse 
the Sensor Cartridge.

• Manual: Manually input the Sensor Cartridge barcode information. Contact 
Agilent Seahorse Technical Support for this step. 

• Cancel Assay: Cancel the assay.

Figure 42 Barcode read failure 
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Agilent Seahorse XFe
Manually enter sensor cartridge barcode

1 To display the Cartridge Barcode window, click Manual. (See Figure 43.) 

2 Call the appropriate regional Agilent Seahorse Technical Support telephone 
number to assist with entering the Sensor Cartridge barcode info for each 
field on the form. (See Figure 43.)

Figure 43 Cartridge barcode manual entry form
Cell plate barcode read failure
For any Cell Plate barcode read errors, Wave Controller will display the 
message shown in Figure 44 and two corrective actions: 

• Manual: Manually input the Cell Plate barcode info. 

• Cancel Assay: Cancel the assay.

Figure 44 Cell Plate Barcode Read Failure
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2 Perform Assay on the Agilent Seahorse XFe Analyzer
Manually enter cell plate barcode information

1 Click the Tray Widget. (See Figure 40 on page 38.)

2 To eject the Cell Plate, click Open Tray.

3 The Cell Plate barcode is located on the side of the plate. Write down the 
barcode information.

4 Click Close Tray.

5 On the Cell Plate Manual Barcode Entry window, enter the Cell Plate 
barcode, and click Accept. (See Figure 45.)

Figure 45 Cell Plate Manual Barcode Entry
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The primary purpose of Wave Desktop software is for data analysis of result 
files generated by Agilent Seahorse XF, Agilent Seahorse XFe, and Agilent 
Seahorse XFp Analyzers. Wave Controller software for XFe Analyzers enables 
the same analysis features (for XFe data only), but analysis is strongly 
discouraged on the XFe Controller. 
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3 Analyzing Assay Results
Assay Result Files
44
Assay result files (*.asyr) are generated by XFe and XFp Analyzers only, and 
contain all data acquired during an assay. Examples of what type of data is 
acquired and stored in assay result files include: 

• Rate data (OCR, ECAR, PER, and PPR)

• Level data (mmHg or mpH)

• Calibration results

• Consumable information from the barcodes on the cell plate and sensor 
cartridge used in the assay

In addition, any details added to the assay template file about the experiment, 
such as groups, compound, pretreatments, is migrated and saved in the assay 
result file. Most of this information can be edited using the Modify function. For 
more information, see “Modifying Assay Result Files" on page 67 for more 
information. After completing an XF assay, save the result file to a USB flash 
drive (or network directory), and open the result file on your personal 
computer using Wave Desktop. The default analysis view for every new assay 
result file is called Quick View. Reopening a saved result file always displays the 
last-modified or viewed analysis view. Each analysis view can be added to an 
assay result file using the Add View button. The four analysis views in Wave 
software are: 

• Quick View

• Overview

• OCR vs. ECAR 

• Data 
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Analyzing Assay Results 3
Analysis View #1 - Quick View
Agilent Seahorse XFe
Quick View is the default analysis view displayed when opening a new assay 
result file. Quick view simultaneously displays a kinetic graph of OCR vs Time, 
ECAR vs Time, and a scatter plot of OCR vs. ECAR. (See Figure 46.)

Figure 46 Quick view
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3 Analyzing Assay Results
Analysis View #2 - Overview
46
Overview displays a kinetic graph of rate (OCR, ECAR, PER, or PPR) versus time. 
The selected rate is displayed on the y-axis, and Time is fixed on the x-axis. 
Group statistics (average rate and error) for each measurement can be 
displayed by checking the Details box in the Group List below the kinetic graph. 
Overview is the most versatile analysis view in Wave software for most routine 
analysis functions. To display Overview, click Add View in the center of the 
ribbon menu, and select Overview from the list of views. (See Figure 47.)

Figure 47 Overview view
NOTE Add multiple Overview analysis views repeating the process of Add View > Overview from 
the list of analysis views. This facilitates generating several customizable overview analysis 
views to display specific assay groups, or compare a control group versus experimental 
groups, groups treated with various compound concentrations or other variables measured 
in the assay.
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Analysis View #3 - OCR vs. ECAR 
Agilent Seahorse XFe
The OCR vs. ECAR view displays the OCR on the y-axis and (by default) ECAR on 
the x-axis. To display OCR vs. ECAR, click Add View in the upper-left region of the 
screen, and select OCR vs. ECAR from the drop-down menu. Use the rate 
drop-down menu to change the rate displayed on the x-axis to either PER or 
PPR. OCR is always displayed on the y-axis, and cannot be changed. 
(See Figure 48.)

Graph title and Quadrant labels

The default graph title is Energy Map. (See Figure 48.) The corners of the 
Energy Map have labels representing the relative bioenergetic state of the 
group(s) related to each other for the selected rate measurement. To modify 
the graph display, including the Graph Title and the Quadrant Labels, click the 
Settings cog. (See Figure 49.)

Dual rate display on Plate Map

The Plate Map displays two rate measurements within each well (OCR vs. 
ECAR, OCR vs. PER, or OCR vs. PPR) as indicated by the legend below the 
Plate Map. (See Figure 48.)

Figure 48 OCR vs. ECAR view

Figure 49 Graph display modification options
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3 Analyzing Assay Results
Chart Types in Wave

Kinetic graph (rate versus time)
48
A kinetic graph is the most common way to display rate data from Agilent 
Seahorse XF Analyzers. (See Figure 50.) The kinetic graph displays the rate 
measurement on the y-axis, and the time on the x-axis. During an assay, data is 
acquired and plotted in real-time as a kinetic graph. Kinetic graphs are also 
found in the Quick View and Overview analysis views. 
Scatter plot (rate 1 versus rate 2)

Figure 50 Kinetic graph
Another common way to express result data is a scatter plot of OCR vs. ECAR, 
where OCR is plotted on the y-axis, and ECAR plotted on the x-axis. (See 
Figure 51.) Data points are displayed on the OCR vs. ECAR scatter plot for a 
single rate measurement for each group in the assay. The OCR vs. ECAR graph 
is only available for analysis, not while running an XF assay.
Figure 51 Scatter plot
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Analyzing Assay Results 3
Plate Map 
Agilent Seahorse XFe
The Plate Map displays rate data for the selected rate measurement of each 
assay well. (See Figure 52.) Plate Maps are always displayed in the upper right 
corner of Wave while running an assay, and on the Quick View, Overview, OCR 
vs. ECAR analysis views. The Quick View has a button to display the Plate Map, 
which is hidden by default. The default rate measurement displayed on the 
Plate Map is rate measurement 1. 

To change the measurement displayed in the Plate Map, use the Measurement 
drop-down above the kinetic graph or scatter plot. (See Figure 53.) The Rate 
Highlight tool on the kinetic graph will move to the selected rate. Hide the Rate 
Highlight tool by clicking Options above the kinetic graph/scatter plot, and 
uncheck Show Rate Highlight.

Figure 52 Plate map

Figure 53 Measurement drop-down
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3 Analyzing Assay Results
Bar Graph
50
The Bar Graph below the Plate Map displays the average rate for each group 
(by default) for a selected measurement. (See Figure 54.) Use the Display 
drop-down menu to change the rate display from Group (average) to Well 
(individual well) mode. 

The Bar Chart graph is only available during analysis, not while running an 
assay. The Bar Chart view provides an alternate data display that can facilitate 
outlier identification, optimal FCCP concentration, optimal cell seeding 
density, or other trends that may not be obvious when viewing data as kinetic 
graph or scatter plot. 

Figure 54 Bar graph
Group List (legend)
The Group List is the legend for the data plotted in the kinetic graph/scatter 
plot. (See Figure 55.) It provides several functions to modify the data plots:

• Hide groups from the data plot by double-clicking the name of the group. To 
unhide the data from the graph, double-click the hidden group again. When 
a group is hidden, the mean and standard deviation of the group will be: 
Mean: 0.00 and Standard Deviation: 0:00. 

• Display group statistics for the selected rate measurement by checking the 
Details box in the upper-right corner of the Group List. Statistics are 
displayed as average and error for the selected rate measurement. Select a 
different rate measurement to display group statistics for that rate. Assay 
wells that have been turned OFF on the Plate Map are not included in the 
calculated group statistics. 
Figure 55 Group list
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Types of Data in Wave 

Rate data: OCR and ECAR
Agilent Seahorse XFe
Use the Rate drop-down box to view the rate data options. (See Figure 56.) The 
two rates measured by the Agilent Seahorse XF Analyzers are:

• Oxygen Consumption Rate: (OCR) (pmol/min)

• Extracellular Acidification Rate: (ECAR) (mpH/min)

Figure 56 Rate data drop-down
Level data: O2 and pH
To view Level data for O2 and pH levels for each rate measurement during the 
assay, use the Y1: drop-down. (See Figure 57.) The O2 level data is displayed as 
oxygen tension in units of mmHg. As the biological material in the well 
consumes oxygen during a measurement, the oxygen tension will decrease. 
This decrease in oxygen tension during a used to calculate the rate of oxygen 
consumption (OCR). The pH level data displays the changes in pH for each rate 
measurement, and is used to calculate ECAR. Level data can be displayed 
while running an assay, and on the Overview and Data analysis views. 

Figure 57 Y1 Drop-down

Figure 58 Oxygen Consumption Rate (OCR) data in Rate mode (left). 
Oxygen tension (O2) data displayed as mmHg in Level mode (right). 
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3 Analyzing Assay Results
Introduction to Acidification Data
52
The Agilent Seahorse XF Analyzer sensor probes measure changes in the 
concentration of free protons in the microchamber in real-time; this data is 
referred to as Extracellular Acidification Rate (ECAR). ECAR can be 
transformed into a number that reflects the number of protons extruded over 
time, Proton Production Rate (PPR), and Proton Efflux Rate (PER). Table 2 
shows the types of acidification data.

Table 2 Types of acidification data

Type of acidification data: ECAR PER PPR

Detects acidification from all sources? Yes Yes Yes

Changes with media formulation? Yes No No

Accounts for buffer factor of the system? No Yes No

How buffering is accounted for? None Buffer factor Buffer capacity

Displayed while running assay? No No No
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Proton Efflux Rate 
Agilent Seahorse XFe
PER is a new rate measurement calculated in Wave software. PER delivers a 
quantitative measure of extracellular acidification and is only available in 
post-run assay results. It is not displayed while running an assay. ECAR is the 
default reported acidification data in Wave software. The three rate options 
displayed in the Rate Measurement drop-down menu are: OCR, ECAR, and PER 
(previously PPR was the default). To change the reported acidification data 
option to PPR, use the Options menu under Wave Home. PER is calculated using 
the following equation: 

PER (pmol H+/min) = ECAR (mpH/min) × B.F. (mmol/L/pH) × Geometric Volume (µL) × Kvol

Table 3 Wave volume variables

Variable Unit Description

Extracellular Acidification 
Rate (ECAR)

mpH/min Rate data measured during an assay, reported as 
the rate of change in mpH in an assay well. 

Buffer Factor (BF) mmol/L/pH Measure of the in situ buffer capacity obtained in 
XF instruments, and accounts for both medium 
buffer capacity and XF assay conditions. For 
standard XF Glycolytic Rate Assay media, this 
value is prepopulated.

Geometric volume µL Physical (geometric) volume of the measurement 
microchamber.

Volume scaling factor (Kvol) No units Volume scaling factor used to account for total 
proton production in the measurement chamber.
Display PER data in Wave
Wave software calculates and reports total PER on the Overview, OCR vs. 
ECAR, and Data analysis views for the following XF Analyzers: XFe96, XFe24, 
XFp, and XF96. Use the Rate Measurement drop-down menu to select PER as the 
rate to display on the kinetic graph (Overview analysis view), or scatter plot 
(OCR vs. ECAR analysis view). 

If PER is displayed

Wave automatically displays PER in two scenarios: 

• When the Buffer Factor is automatically read from the sensor cartridge 

• The assay media selected is the XF Glycolytic Rate Assay 

The equation above demonstrates how PER is calculated in Wave software - the 
only user-changeable variable in the equation is Buffer Factor. A default Buffer 
Factor is automatically used for the PER calculation. If you are using a custom 
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assay medium, then Buffer Factor must be determined manually. Refer to the 
Agilent Seahorse XF Buffer Factor Protocol (available in the XF Glycolytic 
Rate Assay Report Generator download folder) for guidance. 

If PER is NOT displayed

Older result files in which the Buffer Factor is not included will show zero for 
PER. PER will not be displayed:

• For XF24 and XF24-3 sensor cartridges

• For Spheroid and Islet plate types

• For assay template/assay result files that do not have the Glycolytic Rate 
Assay Medium (DMEM-based) or (RPMI-based) selected, OR if a custom 
Buffer Factor value is not entered.

• When background well Buffer Factor values have not been configured.

Using Agilent Seahorse XF Glycolytic Rate Assay Medium, display PER data

1 Open the assay result file in Wave software.

2 Click Modify.

3 Click Add next to Assay Media. (See Figure 59.) 

4 To select the assay medium, use the Media catalog drop-down menu. 
(See Figure 60.)

• Glycolytic Rate Assay Medium (DMEM-based)

• Glycolytic Rate Assay Medium (RPMI-based)

Figure 59 Assay Media option

Figure 60 Assay medium media menu
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Agilent Seahorse XFe
5 To configure Background Well Buffer Factor, click Assay Media. (See 
Figure 61.)

6 Click Configure.

7 Under the column header GRA Media, check the boxes next to each 
background well, and click Save. (See Figure 61.)

8 Assign the Assay Media to each group in the group list. First click 
Collapse/Expand All to display the Group Definitions for each group. 

9 Use the Media drop-down menu to select the newly-added Glycolytic Rate 
Assay Medium (DMEM-based) or (RPMI-based) for each group.

10 When finished, click Apply.

11 The kinetic graph and scatter plot will display PER data when selected 
using the Rate drop-down menu.

12 When finished with analysis, save the changes made to the result file. 

Figure 61 Configure background buffer factor 

Figure 62 Media drop-down menu
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Display PER for assays run with custom assay media

Prior to running the assay, calculate the Buffer Factor of the custom assay 
medium. Follow the steps in the Agilent Seahorse XF Buffer Factor Protocol 
(available in the XF Glycolytic Rate Assay Report Generator download folder) 
for guidance.

1 Open the assay result file in Wave software.

2 Click Modify.

3 Click Add next to Assay Media.

4 In the Edit Assay Medium window, enter the Buffer Factor in the field 
provided.

5 Next, click Assay Media again to configure Background Well Buffer Factor.

6 Click Configure.

7 Under Buffer Factor (mmol/pH), type in the same Buffer Factor value and 
click Save. (See Figure 63.)

8 Assign the Assay Media to each group in the group list. First click 
Collapse/Expand All to display the Group Definitions for each group. 

9 To select the appropriate medium for each group, use the Media drop-down 
menu.

10 When finished, click Apply.

11 The kinetic graph and scatter plot will display PER data when selected 
using the Rate drop-down menu.

12 When finished with analysis, save the changes made to the result file. 

Figure 63
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Data Analysis Using the XF Glycolytic Rate Assay Report Generator
Agilent Seahorse XFe
Wave software calculates and reports total PER. If you performed the 
XF Glycolytic Rate Assay, you must export data to the XF Glycolytic Rate 
Assay Report Generator to calculate glycoPER, the rate of glycolysis-specific 
proton efflux. (See Figure 64.)

1 Open the assay result file in Wave software.

2 Click Export.

3 Select the XF Glycolytic Rate Assay Report Generator from the list.

4 Modify the file name or save location if necessary, then click Save.

Figure 64
Export total PER data 
PER data is exported to both Microsoft Excel and GraphPad Prism file exports. 
(See Figure 65.) For manual PER data analysis or graphing purposes, export 
data from Wave to either file types using the Export function located in the 
top-level ribbon. 

Figure 65 Exported data examples 

GraphPad Prism Microsoft Excel
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3 Analyzing Assay Results
Proton Production Rate
58
PPR is calculated in Wave software using the following equation:

PPR (pmol H+/min) = ECAR (mpH/min) × Buffer Capacity (mol/L/pH) × Geometric Volume (L)
Report PPR data in Wave
The default Acidification Data displayed in Wave software is PER, PPR is not 
available for selection in the Rate Measurement Drop-Down Menu until it is 
enabled in the Wave General Options:

1 Open Wave software.

2 Click Options.

3 Under General Settings > Acidification Data click the radio button next to 
Report PPR; Use Buffer Capacity (mol/L/pH).

4 Click Save.

5 Close/reopen Wave software for the changes to take effect.
Display PPR data in Wave
Wave software reports PPR data on the Overview, OCR vs. ECAR, and Data 
analysis views when enabled, and is calculated using ECAR data and Buffer 
Capacity of the assay medium used. 
Buffer capacity
Buffer Capacity is required for calculating PPR from acquired ECAR data. 
Buffer Capacity changes based on the constituents of the medium. Individual 
constituents have different abilities to buffer the medium from pH changes. 
For accurate PPR data, the Buffer Capacity of each medium used must be 
measured and entered on Modify > Group Definitions tab in an assay result file. 

Record Buffer Capacity of an individual assay medium: 

1 Open an assay result file.

2 Click Modify > Group Definitions.

3 Double-click Assay Media (if an assay medium is not specified, use the Add 
button to add an assay medium).
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4 Click the assay medium and enter the Buffer Capacity value. (See Figure 66.) 
If no Buffer Capacity is entered, the default value of 0.00078 is used. If more 
than one assay medium is used, repeat the same steps for each additional 
media.

Record Buffer Capacity for background wells

1 Double-click Assay Media below Group Definitions. 

2 Click Configure. 

3 In the Configure Background Buffer Capacity window, type in the Buffer 
Capacity value for each background well listed. (See Figure 67.) If only one 
assay medium is used, enter the same Buffer Capacity value. If more than one 
assay medium is used, enter the Buffer Capacity of the assay medium for the 
appropriate background well. 

Figure 66 Buffer Capacity value

Figure 67 Configure Background Buffer Capacity window
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Baseline to a Rate Measurement (%)
60
The Baseline function in Wave software enables rate data to be expressed as a 
percent of a selected rate measurement, or as a percent of a control group. Use 
the Baseline drop-down menu located on the Overview and OCR vs. ECAR 
analysis views (only). Select a Rate measurement to express kinetic data as a 
percent of that rate measurement. (See Figure 68.)

Figure 68 Baseline to Rate measurement examples

Raw OCR kinetic data expressed as (pmol/min)

OCR kinetic data expressed as a percent of rate measurement 3 (%)
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Baseline to a Control Group (%)
Agilent Seahorse XFe
A new baseline feature allows rate data to be expressed as a percent of a 
Control Group. The example shown in Figure 69 shows the appropriate use of 
this feature. A Control group (blue line) with only media injections is selected 
as the baseline control group to baseline the two assay groups Glucose 
Dependency (orange line) and Glucose Capacity (green line). Figure 69 shows 
how this feature can provide a better graphical representation of the effect of 
glucose inhibition on OCR, and facilitate data interpretation.

Figure 69 Baseline to Control group examples

Raw OCR kinetic data for the XF Mito Fuel Flex Test 
expressed as (pmol/min)

OCR kinetic date for the XF Mito Fuel Flex Test expressed as 
a percent (%) of the selected Baseline group (Control group)
Standard Deviation and Standard Error of the Mean
Two types of error bars in Wave are Standard Deviation (StdDev) and Standard 
Error of the Mean (SEM). Use the Error Format drop-down menu to change the 
error bar type displayed on the kinetic graph/scatter plot and the Group List. 
(See Figure 70.) to hide error bars from the data graph, select None. In Well 
mode, error bars are not displayed.

Figure 70 Error Format menu
9
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Rate Overlay: OCR, ECAR, PER, PPR, O2, or pH 
62
Compare rates or level of data acquired during an assay from on one kinetic 
graph for one or more groups. Select data to overlay with the Y1 data using the 
Y2 drop-down menu above the kinetic graph. (See Figure 71.)

Figure 71 Rate overlay
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Customizing Data Displays

Excluding assay wells 
Agilent Seahorse XFe
By default, all assay wells on the Plate Map are turned ON when opening a new 
assay result file. Click an assay well to change the state of the well, excluded or 
included in the group statistics and graphed data for the select group. Assay 
wells that are turned off on the Plate Map have a grey background. (See 
Figure 72.) Assay wells that are included in the graphs and group statistics 
have a white background. (See Figure 72.) Assay wells must be manually 
turned off from each analysis view. Turning off an assay well on one analysis 
view does not apply to other views.

Column and row headers can be used to exclude entire vertical or horizontal 
sections of a Plate Map. Click the numerical column header or letter header for 
a row to turn the assay wells in that column or row OFF. 

Click the small triangle in the upper-left corner of the Plate Map to turn off all 
assay wells on the Plate Map. (See Figure 73.) Charts on this analysis view will 
not display any groups since all assay wells are turned off.

Figure 72 Assay well states

Figure 73 Plate Map toggles

Two assay wells in this group are 
turned OFF. These assay wells 
are excluded from the graph and 
group calculations. 

All assay wells in this group are 
turned on and included in the 
graph and group calculations. 
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Display modes: group and well
64
Rate data is graphically displayed in Group mode on all analysis views by 
default. Group mode displays the average rate value based on the assay wells 
in each group for each measurement. Group mode displays a single kinetic 
trace for each group on the Overview analysis view, and a single data point per 
group for each rate measurement on the OCR vs. ECAR view. In Group mode, 
error within each group is displayed as Standard Deviation or Standard Error 
of the Mean. Switch to Well mode to display individual kinetic traces or data 
points for each assay well in each group. Error bars are not displayed in Well 
mode.

Figure 74 Example of an OCR kinetic graph in Group and Well mode

Group mode

Well mode
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Resize and Adjust view areas 

View areas on the different analysis views can be adjusted in two ways: using 
the gray borders (red arrows in Figure 75) and the << and >> arrows (outlined 
in red in Figure 75) to hide entire regions of the view (Overview pictured in 
Figure 75). Stretch or reduce the size of the kinetic graph using the border 
between the kinetic graph and Plate Map. Hide the Group List to increase the 
vertical size of the kinetic graph using the border between the kinetic graph 
and Group List. Hide the Bar Chart using the border between the Plate Map 
and Bar Chart.
Figure 75 View areas
Zoom, Pan, and Restore 

The Zoom, Pan, and Restore buttons are displayed above the kinetic graph on 
the Overview and the scatter plot on the OCR vs. ECAR view.

Zoom Right-click and hold to select an area on the kinetic 
graph or scatter plot to magnify the selected area.

Pan After zooming into a section of a graph, use the Pan 
button to move around the graph while keeping the 
selected zoomed display aspect ratio.

Restore Return the graph to full view.
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Graph display options
66
To show the graph display formatting options menu, click the cog next to the 
restore button. 

• Minimum and Maximum: Set the minimum and maximum bounds for the Y1, 
Y2, and X-axes.

• Interval: Set the major units for the Y1, Y2, and X-axes.

• Thickness: Add and adjust thickness of Y1, Y2, and X-axes gridlines. Adjust 
values in 0.50 intervals. Default value is '0.00' (no gridlines displayed).

• Show Error Bars: Toggle error bars ON/OFF. 

• Show Zero Line: Display a horizontal reference line at the zero when the 
y-axis is negative.

• Point-to-Point: Display point-to-point rates for the selected axis.

• Show Rate Highlight: Toggle ON/OFF display of the vertical blue rate 
highlight bar on the kinetic graph (indicates the selected rate measurement 
that corresponds to values displayed on Plate Map).

• Show Injections Marker: Toggle the vertical injection lines on the kinetic 
graph ON/OFF.

Figure 76 Graph display options
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Modifying Assay Result Files
Agilent Seahorse XFe
Modify enables you to add or edit details of an assay result file. Modify is 
most-frequently used to add important experiment notes or add additional 
Group Definition details (group names, compound injections, pretreatment 
details, and reassign assay wells to an outliers group or unassign assay wells 
from the Plate Map entirely). To display the Group Definitions, Plate Map, 
Injection Names, General Information as tabs, click Modify (in the Functions 
ribbon). The Group Definitions is always displayed by default.

The views in Modify mode look almost identical to the template designer 
views. When actively modifying an assay result file, Wave will indicate the 
program is in Modify mode in the upper-left corner of Wave (upper-left corner 
of Wave). To return to assay result data, click Apply (upper-right corner of 
Wave) to apply modifications to the assay result file, or click Cancel to cancel 
out of Modify mode and prevent any changes from taking effect.

The Modify function enables textual changes only, and is for adding notes or updating 
Group definitions 

NOTE
details of an assay. Wave does not allow or enable access to edit rate data acquired during 
the assay.
To display the Injection Strategies, Pretreatments, Assay Media and Cell Type 
details entered in the assay template prior to running the assay, select Group 
Definitions. Modifications to the Group Definitions tab include: 

• Renaming assay groups

• Reconfigure details for one or more groups

• Add additional group information that was left out of the initial assay 
template design, or 

• Add Buffer Factor to calculate PER
Plate Map 
To display and edit conditions of each assay group using the drop-down menus 
below the group name, select Plate Map. This tab also enables reassigning group 
locations on the Plate Map. select a group, then select the appropriate assay 
wells on the Plate Map.
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Injection Names 
68
To edit the name of each compound injection during the assay, select Injection 
Names. The specified injection names from the Instrument Protocol tab are 
displayed above each injection line on a kinetic graph. The default name of 
each injection is: 'Injection 1', 'Injection 2', Injection 3', and 'Injection 4'. Type 
an Injection Name for each compound injection, and click Apply to display the 
new name above the corresponding injection line. 
General Information 
To edit details of an assay result file, such as: Project Name, PI, Well Volume, or 
Port Volumes, select General Information. 
Normalization
In the context of a Agilent Seahorse XF assay, normalization is the process of 
recalculating rate data to account for variations in a relevant cell parameter 
(such as cell count or protein concentration) that can cause well-to-well 
variability. The Normalization function in Wave provides a simple method to 
apply normalization data to the measured rate data. To use the normalization 
function, an independent assessment of the assay wells for cell number, DNA 
content, protein concentration or similar parameter is required. (See 
Figure 77 on page 69.)

To normalize data in Wave, three components are used:

• Normalization Values (required): The numeric data generated from the 
independent assessment of the well (cell count, protein concentration, DNA 
content, and so forth).

• Normalization Unit (required): This alphanumeric field describes the 
units to which the data are to be normalized. It comprises the desired value 
to which the data will be normalized (see Normalization Scale Factor) plus 
the unit of measure of your normalization values (such as “cells”, “mg”, 
“ng”, and so forth).

• Normalization Scale Factor: This number determines what value the rate 
data will be normalized to. Default is 1 and adjustment is optional.
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Figure 77 Normalization mode
Add normalization values
To display the Edit Normalization Mode, click Normalize (in the Functions 
ribbon). The Normalization Values table is where to copy/paste normalization 
data in Wave, two ways to add normalization data are: 

Option #1:

1 Open the independent normalization data file, the data must be in the same 
grid format as the Normalization Values table. 

2 Select the normalization data and copy to the clipboard [Ctrl+C].

3 Open a Agilent Seahorse assay result file in Wave Desktop. 

4 Click Normalize. 

5 To insert the copied data the Normalization Table, click Select All > Paste.    

6 Click Apply. 

Option #2:

1 Open a Agilent Seahorse assay result file in Wave Desktop. 

2 Click Normalize. 

3 Type each value into the Normalization grid manually.

4 Click Apply. 

Background wells should be left blank on the Normalization Table. 
NOTE
Normalization unit

Before applying normalization values, Wave requires a Normalization Unit. 
The Normalization Unit is displayed on the Y1 axis title on the kinetic graph 
when normalization is applied and checked ON. 
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For example, type µg Protein into the Normalization Unit field, and the Y1 axis 
label for OCR will be displayed on the kinetic graph as: (pmol/min/µg Protein). 
When using the Normalization Scale Factor, the scale factor value must also be 
entered to the Normalization Unit field. 

Normalization scale factor

The Normalization Scale Factor allows you to scale normalized data to a 
specific factor, such as cell number. It is often preferable to normalize to an 
average or rounded number. 

Enter a scale factor value to recalculate and multiply normalized rate data 
based on the equation shown below: 

Normalized Rate (well)=[Rate (well)/(Normalization Value)]*Normalization Scale Factor

For example, if assay wells contain values of 12052, 12503, and 12757 cells per 
well, a user might enter 10000 as the normalization scale factor. 

Be sure to enter the same value in the Normalization Unit field to display the factor 
NOTE
correctly on the y-axis. For example, if using cell count and the scale factor is 10000, enter 
10000 cells as the Normalization Unit.
Viewing normalized data

After applying changes made to the Normalize function, the Normalization 
checkbox will become active on all analysis views. Toggle the checkbox 
ON/OFF to change the data display between normalized and nonnormalized 
rates on the kinetic graph, scatter plot, and Plate Map. All data graphs will 
display the Normalization Unit entered. (See Figure 78.)

Figure 78 Normalized data
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Wave Data Export Options
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Assay result data can be exported from Wave for additional analysis, graphing, 
or other purposes. Use the Export button to display the available export options 
from any analysis view, or right-click a graph/Plate Map to display the menu 
options for exporting data. To export raw data, select Microsoft Excel or 
GraphPad Prism options from the list. Create a customizable summary report by 
exporting data to an XF Report Generator. Select the XF Report Generator 
that matches the Agilent Seahorse assay type. 
Export to Microsoft Excel
Export assay result data to Microsoft Excel from Wave for additional data 
analysis or graphing purposes.

1 Click Export (in the Functions ribbon).

2 Click Microsoft Excel.

3 Choose a save location, and click Save.

Using the export function described above, there will be between 7–13 tabs in 
the exported Excel file depending on the data configured in Wave:

• Raw data: Exporting raw result data (not normalized, baseline OFF) will 
have seven tabs of data. (See Figure 79.)

a Assay configuration: Information from the assay result file including 
the Group Layout (Plate Map), Cartridge/Cell Plate Barcode and other 
information, Instrument Protocol, and normalization data and 
normalization unit.

b Rate: Raw OCR, ECAR, and PER or PPR data in a column format 
organized by measurement. 

Figure 79 Raw data

Rate (Plates) Tab: Raw OCR rates 
for rate measurement 1 (from an 
Agilent Seahorse XFp Analyzer). 
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c Rate (Columns): Raw OCR, ECAR, and PER or PPR data in a column 
format organized by group. Similar output format to the GraphPad Prism 
export.

d Rate (Plates): Raw OCR, ECAR, and PER or PPR data organized by 
measurement displayed as a Plate Map.

e Raw: Raw assay well data for temperature, emission values and 
reference values. Often used for troubleshooting by Agilent Seahorse 
Technical Support.

f Calibration: Raw calibration data for both the O2 and pH channels.

g Operation log: List of each protocol command executed by the analyzer, 
timing of the command, and outcome (success/fail).

• Normalized data: Exporting result data that has been normalized (baseline 
OFF) will have three additional data tabs in the Excel export. 
(See Figure 80.)

a Normalized rate: Normalized OCR, ECAR, and PER or PPR data in a 
column format organized by measurement. 

b Normalized rate (Columns): Normalized OCR, ECAR, and PER or PPR 
data in a column format organized by group. Similar output format to the 
GraphPad Prism export.

c Normalized rate (Plates): Normalized OCR, ECAR, and PER or PPR data 
organized by rate, displayed as a Plate Map.

Figure 80 Normalized data

Normalized Rate (Plates) Tab: 
Normalized OCR rates for rate 
measurement 1 (from an Agilent 
Seahorse XFp Analyzer). 
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• Baselined data: Exporting result data with baseline ON (recalculated as a 
percent of a rate measurement or of a control group) will have three 
additional data tabs in the Excel export. (See Figure 81.) 

a Baselined rate: Baselined (%) OCR, ECAR, and PER or PPR data in a 
column format organized by measurement. 

b Baselined rate (Columns): Baselined (%) OCR, ECAR, and PER or PPR 
data in a column format organized by group. Similar output format to the 
GraphPad Prism export.

c Baselined rate (Plates): Baselined (%) OCR, ECAR, and PER or PPR 
data organized by rate, displayed as a Plate Map.

Excel export legend

The legend on each tab indicates the assay wells that have been excluded from 
calculations in Wave (turned OFF or unassigned). (See Figure 82.) Assay well 
B in the images below was turned OFF in Wave before exporting to Excel. 

Figure 81 Baseline data

Figure 82 Excel export legend

Baselined Rate (Plates) Tab: 
Baseline OCR rates for rate 
measurement 1 displayed as a 
percentage (from an Agilent 
Seahorse XFp Analyzer). 
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Export select graph data to Microsoft Excel (from any analysis view)

If you wish to only export select data that is displayed on a kinetic graph, 
scatter plot, or Plate Map to Microsoft Excel.

1 Right-click anywhere on a chart or Plate Map to display an option menu and 
select Export Graph Data to Excel. (See Figure 83.) 

2 Browse to the desired save location, type in the file name for the export. 

3 Click Save. 

The data values exported to Microsoft Excel will be in the exact same format 
as they are displayed on the chart or Plate Map. 

Figure 83 Option menu

This Microsoft Excel file export is not compatible with the XF Report Generators. Use the 
Export to GraphPad Prism

NOTE
Export button in Wave software to export data directly to the XF Report Generators from 
any analysis view.
Export assay result data to GraphPad Prism for additional data or statistical 
analysis, or graphing purposes.

1 Click Export (on any analysis view).

2 Select GraphPad Prism. 

3 Choose a save location, and click Save.

Prism export compatibility has been validated using GraphPad Prism versions 6 and 7.
NOTE
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GraphPad Data tables

Wave exports rate data (OCR, ECAR, PER or PPR) to GraphPad as: 

• Raw rate data: always exported

• Normalized rate data: Normalization data must be applied to the assay 
result file in Wave before export

• Baseline rate data: Rate data as a percent of the selected baseline 
measurement or control group

Sample data output in GraphPad Prism from an Agilent Seahorse XFp 
Analyzer with two assay groups, Disease Group and Healthy Group. 
(See Figure 84.)

• Column-format Data Display: Time is a fixed column next to the assay 
groups, and will scroll horizontally when there are more assay groups. 

• Assay Wells and Columns: The number of columns with rate data (below 
each group header) reflects the number of assay wells in each group. 

Figure 84 Sample data output
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• Excluded Assay Wells: Assay wells that have been excluded in Wave will 
appear as an empty column in Prism. Column A:Y3 below Group A (called 
Disease Group) in Figure 84 on page 75 shows rate data that has been 
exported for two wells in the Disease Group. Refer to Project Info or the 
assay result file in Wave for excluded assay wells in the exported Prism file. 

• Rows and Rate Measurements: The number of rows reflects the number of 
rate measurements captured during the assay. In Figure 84 on page 75, 
there are a total of 16 measurements performed during the assay (16 rows). 

GraphPad Kinetic graphs 

Every Data Table in the GraphPad Prism file export also contains a 
corresponding kinetic graph. The graph in Figure 85 represents the data set on 
the previous page from the Agilent Seahorse XFp Analyzer. The Graphs folder 
displays the available kinetic graphs based on the type of data exported from 
Wave, that is, raw data, normalized data, or data as a percent of the baseline. 
Assay wells or groups that are turned OFF in Wave prior to export will be 
excluded from the file export.

GraphPad project info 

Information about the experiment and assay properties is displayed in Project 
info 1 (in the Info folder) including the date the assay was performed, the 
assay result file name, and normalization unit. (See Figure 86.) The Notes 
display on the Project Info view shows the group layout, assay wells in each 
group, and indicates excluded assay wells using brackets (example: [A2]).

Figure 85 Kinetic graph 

Figure 86 Project info view
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Export to Agilent Seahorse XF Report Generators
Agilent Seahorse XFe
Agilent Seahorse XF Report Generators are Microsoft Excel macro files that 
automatically calculate the parameters of the selected Agilent Seahorse XF 
assay, and present the data in a one-page, customizable Summary Report. 
Wave enables a simple, one-click direct export of result data to the Report 
Generators. Any modifications in Wave will be incorporated in the exported 
Report Generator file, including excluded outlier assay wells and normalizing 
data.

The five Agilent Seahorse Report Generators embedded in Wave are:

• XF Glycolysis Stress Test Report Generator

• XF Glycolytic Rate Assay Report Generator

• XF Cell Energy Phenotype Report Generator

• XF Cell Mito Stress Test Report Generator

• XF Mito Fuel Flex Test Report Generator

Figure 87 Embedded report generators
NOTE The Agilent Seahorse XF Report Generators are validated for compatible with MS Excel 
2010, 2013, and 2016 on Windows PCs and MS Excel for Mac 2011 and 2016 for Apple PCs. 
For more information on a specific XF Report Generator, refer to the appropriate Report 
Generator User Guide on the Agilent website.
Export data to an XF Report Generator from any analysis view

1 Open assay result file and modify data as necessary.

2 Click Export.
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3 Select the Agilent Seahorse XF Report Generator that applies to the result 
data.

4 The Report Generator file name matches the assay result file name by 
default. Enter a new file name if desired, select a save location, and click 
Save to save the Report Generator file. 

5 Open the Report Generator file, and select groups to display. The Select 
Groups dialogue box is displayed automatically the first time data is 
exported to the XF Report Generator.

6 To save the Summary Report, click Save.

When exporting an assay result file that has data from two different assays on the same 
NOTE
Cell Plate (such as a Agilent Seahorse XF Cell Mito Stress Test and Glycolysis Stress Test), 
turn OFF groups that do not apply to the Report Generator you are exporting to first. Repeat 
the same process for the other assay groups and Report Generator.
Best practices for exporting data to the Agilent Seahorse XF Report Generators 

Enable Macros in the Trust Center Before using a XF Report Generator, macros 
must be enabled. Macros are disabled with notification in the Microsoft Excel 
Trust Center by default. Opening a newly-exported Report Generator will 
display a security warning to enable the macro. To use the XF Report 
Generator, click Enable Content. This must be enabled for subsequent XF Report 
Generator file exports. 

To always enable macros and not be prompted to Enable Content each time a 
Report Generator file is created, enable all macros in the Microsoft Trust 
Center.

1 Open Microsoft Excel.

2 Click File>Options.

3 Click Trust Center>Trust Center Settings.

4 Click Macro Settings.

5 Select Enable all macros, and click OK.

Exporting normalized data to a Report Generator  Normalized rate data in Wave 
will be exported and used for parameter calculations in the Report Generator. 
Normalized data is displayed by default after selecting groups to display. To 
toggle the rate data display between normalized and raw data, use the 
Normalize button on the Summary Printout page. The Normalize tab in the 
Report Generator will display the normalization values, unit, and scale factor 
as exported from Wave. (See Figure 88 on page 79.) For data integrity 
purposes, when normalized data is exported to a Report Generator from Wave, 
the Normalize tab in the Report Generator is locked for editing. 
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The Normalize tab in the Report Generators provides a step-by-step explanation 
on how to edit the normalization values imported to the Report Generator. 
(See Figure 89.) 

Excluded assay wells in Report Generator Assay wells that are turned off in 
Wave will not be exported or included in parameter calculations for each 
group in the Report Generators. This also applies to entire groups in an assay 
result file. Groups turned off in Wave will not be exported to selected Report 
Generators. The Measures Sheet displays the group names, Plate Map layout, 
and any assay wells that have been excluded in the group calculations in the 
Report Generator. (See Figure 90.)

Figure 88 Normalize tab view

Figure 89 Instructions to edit the normalization values

Figure 90 Measures sheet
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Summary View
80
The Summary view is added to every assay result file by default, and cannot be 
closed or deleted. The Summary is a place to add notes or other valuable 
information about the assay. You may also append graphs, charts, Plate Maps 
from other views, or add details of the Instrument Protocol or 
Groups/Conditions used in the assay. The Summary is the only location in 
Wave that enables export to Microsoft Word, Adobe PDF, HTML, or Rich Text 
Format (.rtf). (See Figure 91.)
Customize the summary

Figure 91 Summary view
Use the ribbon toolbar to add, edit, and format edit the content added to the 
Summary, such as:

• Cut, copy, and paste to the clipboard.

• Change the font type, size, text, highlight color, and style.

• Subscript or superscript a character or characters.

• Add bullet points or numbers.

• Insert a table, picture or page break.
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Append to summary

Append content from any analysis view directly to the Summary in three ways:

• Append to Summary: Click Summary (in the Functions ribbon) on the Quick 
View, Overview, OCR vs. ECAR views to send all data on the current 
analysis view to the Summary.

• Right-click > Send to Summary: Right-click a kinetic graph, scatter plot, or 
Plate Map and click Append to Summary from the drop-down list. To view 
appended content, click the Summary view. 

• Append Image (Summary view): General Information: The General 
Information button appends an image to the Summary view containing 
information about the assay, including project and plate information.

• Protocol Summary: The Protocol Summary appends the Instrument 
Protocol (Mix, Wait, and Measure steps) as well as the time and number 
of cycles for each measurement to the Summary view. 
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• Group Summary: The Group Summary button appends an image of the 
Plate Map and a table of the Group Definitions to the Summary view. The 
Plate Map is shown below. 

• Port Summary: The Port Summary button appends an image to the 
Summary view of the contents injected from each compound port in the 
assay.
Print and Export summary
To print the Summary view, click the Print button on the Summary toolbar, 
select the printer to use, and click Print.

Export the contents of the Summary view to a Microsoft Word Document, PDF 
file, HTML file, or Rich Text Format file. Click the appropriate icon from the 
Export section of the Summary toolbar, browse to the desired file location to 
save and click Save. 
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Data View
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The Data view contains every piece of data associated with assay result file, 
such as: 

• Group Data: OCR, ECAR, PER, or PPR rate data and error values organized 
by group, and ordered by measurement.

• Rate: OCR, ECAR, PER or PPR individual assay well data. Error values are 
not displayed. 

• Level Data: Individual assay well data displayed as Level data - O2 level 
(in mmHg) and pH raw values.

• Raw: Raw data values obtained during the assay including LED values, 
temperature at each measurement, and internal LED reference values.

• Calibration: Calibration results for each assay well are displayed in a table 
format. 

• Calibration View: Calibration results for each assay well are displayed in a 
Plate Map format. 

• Event Log: XF Analyzer serial number, consumable lot numbers used 
during assay, a command log for processes performed during assay, and 
whether they were successful or failed.

Export the data in a selected tab to Microsoft Excel using the right-click Export 
function. The Calibration, Raw, and Event Log tabs are used primarily for 
internal purposes, including QC, validation processes, and Agilent Seahorse 
Technical Support. 

To display the Data view, click Add View on the top-level ribbon and select Data 
from the drop-down menu. The Group Data tab is displayed by default when 
opening the Data view. (See Figure 92.) 

Figure 92 Data view
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Column sorting
84
To sort the data by a specific column, click on the column header: 
Measurement, Group Name, Time, Rate or error for OCR, ECAR, or PER/PPR. 
Wave will automatically sort the data in ascending or descending order in the 
selected column. 
Display values for: Average, Count, Maximum, Minimum, or Sum
To display the Average, Count, Maximum, Minimum, or Sum, or any 
combination of these values, click the Sigma sign to the right of the arrow, and 
check the applicable boxes. In the example shown below, all values are checked 
for OCR data - Wave will display the average, count, maximum value, minimum 
value, and sum for the OCR data.
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Group Data by Field
Agilent Seahorse XFe
To group the data by field, drag and drop a column header to the gray bar 
above the table. In the example shown below, the Group Name heading was 
dragged to the gray bar. After grouping the data, expand or collapse the 
grouped by clicking on the plus/minus sign to the left of the group.

After expanding a group, select another column heading to define the 
groupings further. In the example below, the heading OCR was dragged to the 
grey bar after Group Name.
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Wave Home: Templates
88
Manage the list of available templates for the Agilent Seahorse XFe and XFp 
Analyzer on the Templates view, Figure 93, by using the Import, Export, 
Duplicate, and Delete buttons.
Import assay templates 

Figure 93 Templates view
Import assay template files to Wave two ways: 

• Double-click the assay template on a USB flash drive, network drive, or 
shared in an email, and Wave will automatically import the template to the 
Templates view.

• Manual Import - Open Wave > Templates view and click Import. Locate the 
template file, and click Open.
Export, duplicate, and remove assay templates
Single-click an assay template on the Templates view to:

• Duplicate: Create an identical copy of a template. 

• Delete: Permanently delete an assay template file from Wave. 

• Export: Export an assay template to:

• A USB flash drive

• A shared network directory for multiple user access
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Template Details
Agilent Seahorse XFe
To display details about an assay template without opening the template file, 
single-click the template to display Template Details. (See Figure 94.) The 
Modified date reflects the most recent date the template was modified and 
changes were saved. Description, Project Name, Project Number, and Investigator 
are optional details and not required to save a template.

Figure 94 Template Details
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Wave Home: Results 
90
The Results view, Figure 95, displays recently opened assay result files, the 
corresponding file directory where each assay result file is located, and 
Favorite Places. Opening a new assay result file displays the default analysis 
view, the Quick View. After modifying and saving an assay result file, Wave 
automatically displays the last modified analysis view the next time the assay 
result file is opened. 
Figure 95 Results view
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Recent assays, recent places, and favorite places
Agilent Seahorse XFe
• Recent Assays displays a sortable and searchable list of recently viewed and 
analyzed assay result files. (See Figure 95 on page 90.)

• Favorites displays user-defined locations (local or network directories) 
where assay result files are frequently added to, or accessed from. Once 
configured, each local directory added as a Favorite Place will appear below 
Recent Assays as a folder icon. (See Figure 96.)

• Recent displays the file location (for both local and network directories) of 
recently opened assay result files in the order of when each result file was 
opened. (See Figure 96.)

Figure 96 Recent Assays, recent places, and favorite places
Options
Click Options, next to Browse in Figure 95 on page 90, to add Favorite Places 
(from local or network directory locations) or configure the number of Recent 
Folders and Recent Assay Files to display on the Results view. (See Figure 97.)

Figure 97 Number options for results view
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Browse
92
To manually open an assay template or assay result file, click Browse. (See 
Figure 95 on page 90.)

The file types compatible with Wave 2.4 are:

• Assay result files (*.asyr)

• Assay templates (*.asyt) 

• Agilent Seahorse XF data files (*.xfd)

Double-click to open an assay design file (*.asyd) created by earlier versions of Wave and 
Sort by 

NOTE
Save As an assay template file. It is not possible to create assay design files using 
Wave 2.4. If you have *.asy files, these must be converted to *.asyr before opening in Wave. 
Contact Agilent Seahorse Technical Support for help with this.
Assay result files are default-sorted by Most Recent, which displays a list of the 
most-recently opened or modified assay result file first. Name sorts assay 
result files alphabetically based on the file name and Instrument sorts by the 
type of Agilent Seahorse XF Analyzer used to generate the assay result file.

Figure 98 Sort by from the results view
Search
Type specific keywords in the Search bar to filter and display assay result files 
whose file name contains matching keywords. Searching using the file 
directory or date is not supported. 

Figure 99 Search from the results view
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Wave Home: Catalog
Agilent Seahorse XFe
The Catalog provides a location to save frequently used Compounds, 
Pretreatments, Media, and Cells. (See Figure 100.) Save time when creating a 
new assay template or customizing a template file by inserting Catalog entries. 
The Catalog is prepopulated with Agilent Seahorse reagents and compounds 
that are used in commercially available Agilent Seahorse assay kits. 
Add a catalog entry

Figure 100 Catalog
1 Open the Catalog view.

2 Select a condition (Compounds, Pretreatments, Media, and Cells). This example 
used Pretreatments.

3 At the bottom of the Catalog > Pretreatments view, type in a Name (required), 
and any additional fields to describe the Pretreatment entry (optional).

4 After adding details, click Add Pretreatment to save the entry.

5 When finished, click Save in the lower-right corner of the Catalog view.
Delete a catalog entry
1 Open the Catalog view.

2 Click the red X at the end of the row to delete.
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Share custom catalog
94
User-customized Catalogs can be shared and uploaded to Wave on XFe 
Analyzer or another user’s Wave Desktop.

Computer #1:

1 Plug in the USB flash drive (if applicable).

2 Start Wave, and open the Options view.

3 The Catalog directory is found under the Directories header on the General 
Options view. 

4 Highlight the path and copy/paste into Windows Explorer to display the 
Catalog folders: CellLine, Compound, Pretreatment, and XFeMedia.

5 Select each Catalog condition to share and copy/paste to the USB flash 
drive (or a network directory). Do NOT cut the Catalog entries.

6 Eject the USB flash drive (if applicable).

Computer #2:

1 Insert the USB flash drive (or open the network directory) containing the 
saved Catalog entries.

2 Start Wave, and open the Options view.

3 In General Options, copy/paste the Catalog directory location in Windows 
Explorer.

4 Close Wave.

5 In Windows Explorer, open each Catalog folder (from Computer #1), and 
copy/paste the contents into the appropriate Catalog folder on 
Computer #2.

6 Eject the USB flash drive (if applicable) and open Wave.

7 Open the Catalog view, and verify the transferred entries are displayed in 
the list for each condition. 
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Wave Home: Options
Agilent Seahorse XFe
The three types of modifiable settings in the Options view are: General, 
Instrument, and Advanced. (See Figure 101.)

Figure 101 Options view
General options 
General settings displays options to:

• View/change Agilent Seahorse file directories (save locations) for Catalog 
and Assay Templates files in Windows Explorer. 

• Modify the reported acidification rates - PER (default) and PPR.

• Enable/disable the What’s New pop-up (list of new features) upon startup of 
Wave 2.4 software. 

• Enable/disable automatic Wave software updates.

After making changes to General options, click Save (lower-right corner) to save 
changes. To restore changes to the factory default setting, click the Default 
button.

Directories

Directories displays the default save location for Catalog entries and Template 
files. (See Figure 101.) The prepopulated Catalog conditions and assay 
template files installed with Wave are stored in this directory, as well as any 
new Catalog entries and assay template files. To change the location of either 
directory, click the […] button to browse to the preferred location. Wave 
software must be restarted for changes to take effect.
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What’s new message box

The What’s New message box appears upon Wave startup, and displays the new 
features and functions available in version 2.4. This message box will always 
appear unless either the Don’t show this again box is checked, or it is disabled in 
the Options view.
Instrument options
Instrument options displays default values (by analyzer type) for the 
Instrument Protocol. (See Figure 102.) To change the XF Analyzers displayed 
in Wave Desktop, see the Wave Desktop 2.4 ReadMe PDF. 

Other settings that can be modified include: 

• Cycles: Number of repeat Mix, Wait, and Measure cycles in the default 
protocol

• Mix, Wait, and Measure times: Time to complete each command in the 
Instrument Protocol

• Default Port Volume (notation purposes only)

• Default Well Volume (notation purposes only) 

Protocol defaults

Leave the default Protocol Defaults untouched, and modify the Instrument 
Protocol in the individual assay template file. To change the Protocol Defaults: 

1 Use the up/down arrows or type in the new values for Mix, Wait, Measure, 
and Cycles.

2 Click Save at the bottom of the screen to save changes.

Figure 102 Instrument options
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Agilent Seahorse XFe
Ports and Wells

The port and well volumes are unique to each Agilent Seahorse analyzer. 
Modifying these values do not change the function of the analyzer or 
calculations, and are for record-keeping only. During an assay, the contents of 
the port will be injected. To change the Port Volume or Well Volume:

1 Use the up/down arrows, or type the new value in the Port Volume field or 
the Well Volume fields. 

2 To save changes, click Save.
Advanced options (Wave controller, Agilent Seahorse XFe analyzers ONLY)
The Agilent Seahorse XFe Analyzer can automatically notify users when 
certain functions are complete or need user interaction, such as:

• Calibration: The Calibration Plate must be replaced with the Cell Plate, and 
the assay must be started.

• Assay Complete: Following completion of an assay, Wave Controller will 
automatically email the assay result file to the specified email addresses.

An active internet connection configured on Wave Controller for the Agilent 
Seahorse XFe Analyzer is required for use of automatic email notification 
features. (See Figure 103.)

Add email recipients

1 Type an email address in the Mail From field, and enter a password for this 
address in the Password field. This email address will be used to send all 
notifications and will be displayed in the Mail From field after receiving a 
notification from the Agilent Seahorse XFe Analyzer.

2 Specify the SMTP Address and the access Port field.

3 Check Enable SSL if required by the local IT group.

4 Type the email address for a single recipient in the Recipient Email Address 
field.

5 Click Add.

Figure 103 Automated Email features
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6 Repeat Steps 4 and 5 for each recipient.

7 When finished adding recipients, click Save. 

8 To send a test notification email to all email recipients, click Test Settings. If 
the test email is not received, verify the correct network settings have been 
configured in Wave Controller. 

Remove email addresses 

Select the email address under Email Recipients, and click Delete. 
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Wave Home: Help
Agilent Seahorse XFe
To quickly and easily send system files for support and diagnostic purposes, 
the Help view displays software version information, Agilent Seahorse 
technical support contact information, and Send System Files. (See Figure 104.)
Send system files

Figure 104 Help view
Use the Send System Files function to automatically compile Wave System Files 
into a compressed folder, create a blank email to attach the System Files, and 
send to Agilent Seahorse Technical Support. (See Figure 105.)

Save system files in a compressed folder: 

1 Open the Help view.

2 Click Send System Files.

3 Click Save to select a file location to save the compressed folder.

Figure 105 Send system files function
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Send system files to Agilent Seahorse technical support:

1 Open the Help view.

2 Click Send. An email message will appear populated with the following 
information:

a Email Recipient - Agilent Seahorse Technical Support email address.

b Subject - Email subject line.

c Email Body Text - displays the default save location of the System Files 
on the local drive.

3 Locate the saved System Files compressed folder, and attach it to the email.

4 Click Send.
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